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Chapter 1: About xPress
2
 

Introduction 

xPress
2
 is an innovative digital press software that enables production of diverse 

documents containing both constant and variable information from different sources. 

Using xPress
2
 you can create documents with different page layouts and copies.  

The software is designed for printing houses, photocopy offices and other businesses 

that print documents with variable data, such as tickets, coupons, stickers, letters, 

checks, etc. For example, create a coupon flyer with a permanent title and 

background and 20 different coupons in the body of the flyer. 

 

System Capabilities 

The xPress
2
 software is flexible and powerful, yet it is easy to operate and allows the 

user to perform numerous actions, including the following: 

 Printing documents with consecutive numbering according to counter 

definitions (e.g., ascending or descending, flat or deep).  

 Inserting different types of objects in a document and determining its preferred 

order and structure.  

 Formatting data using any font and size available in your system. 

 Inserting information from other applications such as Excel data, pictures in 

various formats, ASCII files, etc. 

 Printing an original and any number of copies. 

 Printing different copies from a different printer tray, according to user defined 

options. 



Chapter 1: About xPress2  8 

 

 Printing MICR CMC7 / E13B / OCR-A magnetic lines for checks (for printers 

supporting MICR toners). 

System Requirements 

 Operating system: Windows 2000/XP or higher. 

 Hardware: Pentium 4 system with 512MB RAM or higher 

 Printer: any printer supporting Windows applications. 

For Tray selections, a printer supporting PCL5 language is required. 

For additional information about printing on different printers, please check the 

printer manufacturer’s User Guide. 

 

How to Use this Manual 

This User Manual has been designed to assist xPress
2
 users. In addition to describing 

the system in general, it provides an in-depth explanation of the functions in the 

system. If you are looking for a tutorial that will walk you through the basic xPress
2
 

functions, please refer to the Quick User Guide, also supplied with the xPress
2
 

package. 
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This manual contains the following parts: 

Chapter 1 Provides general information about the xPress
2
 software. It explains 

how to use this manual as well as system requirements. 

Chapter 2 Describes the xPress
2
 software and explains the basic tools and 

concepts you will need in order to use it. 

Chapter 3 Is the most important chapter. It teaches you the basic step-by-step 

processes that you will use in creating new documents, arranging 

various objects and printing. This chapter includes the following 

subjects: 

1. Creating a new document. 

2. Inserting input and output objects. 

3. Defining the object’s characteristics. 

4. Arranging objects in the document. 

5. Printing the document. 

Chapter 4 Describes the different Input and Output objects. 

Chapter 5 Frequently Asked Questions (FAQ). 
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Chapter 2: Getting Started 

Installing the System 

These installation instructions refer to the Windows 2000 operating system. In other 

versions, the screen displays and messages might be slightly different from those 

displayed below, but the principles remain the same. 

To install the software, close all active programs, insert the installation disk you have 

received and wait for a few seconds. The installation wizard will appear. If the 

installation program does not start automatically, double click the SETUP.EXE file 

from the installation disk. 

 When the initial installation screen opens, click the OK button to start the 

installation process. 

 The software license agreement will be displayed, please read this agreement 

carefully. To accept the agreement conditions, check the "I accept all the 

terms of the preceding License Agreement" checkbox, and click Continue.  

If you do not accept the conditions you will not be able to continue the 

installation or to use the software. 

 Select the installation folder or confirm the default path.  

Click the Start Setup button to start the installation. 

 The xPress
2
 program will appear as a default program in the Program Group 

window, click Continue to proceed. 

 Follow the wizard’s instructions and messages, confirm the actions when 

required. 

 When the installation is completed a message will appear. Click OK to 

confirm and finish the setup. 
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Launching xPress
2
 

To launch xPress
2
, simply click on the Start button and choose the Programs option. 

Locate the xPress
2
 program in the Programs List and click on its name. 

 
                                                                                             

 

Running xPress
2
 under Windows Vista / Windows 7 

If you are using the Windows Vista / Windows 7 operating system, after the 

installation instructions above, you will need to run the application once as an 

Administrator. This will enable the software to define some initial printer related 

definitions and settings that are impossible to define if the application is running in 

standard user mode. In order to run the application under administrative privileges, 

you need to go to the folder in which xPress
2
 was installed (usually under 

"C:\Program Files\xPress"), select the application icon, right click it and select 

"Properties". 
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The properties dialog box will 

open, check the "Run this program 

as an administrator" checkbox, 

and confirm the dialog box. Run 

the application. You may be asked 

to provide the administrator 

password or to confirm the 

operating system to switch to 

administrator mode. 

After the application has started in 

administrator mode, define the 

PCL and Postscript paper trays 

(for more information see paper 

tray definitions in page 20), and 

print once in Optimized PCL 

mode and once in Optimized  

Postscript mode. After you have printed once in each of the options, you can return to 

the properties dialog box, uncheck the "Run this program as an administrator" 

checkbox and use xPress
2
 under standard user mode. 
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Application Window 

When you start the system, the application window appears. This is the main working 

window in which you perform all your actions. 

 

The application window includes 4 main parts:  

 The working area. 

 The toolbars and menu bar. 

 The objects tree. 

 The characteristics window. 

 

Working Area 

Objects tree 

Characteristics 

Window 

Toolbars 

Menu Commands 
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Working Area (xPress
2
 Desktop) 

The Working Area (also know as the xPress
2
 Desktop) is the main working space of 

the system. In this area you will place the objects composing the document.  

During your work with the xPress
2
 Desktop, the mouse cursor might change 

according to the activity you perform: 

 Pointing arrow – for selecting objects. 

 Cross shape – for selecting an area for creating a new object. 

 Multi-directional arrow – for moving an existing object. 

 Bi-directional arrow – for resizing an existing object 

 

The Main Menu 

xPress
2
’s

 
Main Menu includes the following options 

File Includes options performed on the entire document, such as open, save, 

print, print preview, etc.  

Edit Includes general editing features.  

View To display or hide toolbars, toolboxes, status bars, etc. 

Tools Tools and options used to edit the document and operate the software. 

Format To format selected objects and arrange them in the document. 

Objects To add input and output objects in the document, duplicate or remove 

them. 

Script Lets you work with the Master Script of the document to achieve special 

and more powerful results using the xPress
2
 software. 

Help This option lets you work with the Help file to assist you in operating the 

xPress
2
 software. 
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xPress
2
 Toolbars 

The xPress
2
 software includes 3 toolbars. Most of the actions operated using the 

toolbars can be also operated from the menu commands. 

 

The Normal Toolbar 

This toolbar includes buttons for the most often-used actions. You might be familiar 

with the buttons of this toolbar from other Windows applications. 

    1    2    3     4    5   6     7    8     9   10   11   12  13   14  15 

 

1 - Create a new document. 

2 - Open an existing document. 

3 - Save the active document. 

4 - Cut objects to clipboard. 

5 - Copy objects to clipboard. 

6 - Paste objects from clipboard. 

7 - Undo last action. 

8 - Redo previous action. 

9 - Display the document in print preview mode. 

01 - Print the document. 

00 - Open the event log viewer dialog box. 

01 - Open the master script of the document in the script editor. 

01 - Execute the master script of the document. 

04 - Gives information about the object on which you place the cursor. 

05 - Open the About dialog box. 
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The Objects Toolbar (Toolbox) 

This toolbar, also known as the Toolbox, is designed for adding new objects into the 

document, and selecting which objects are displayed in the working area. It lets you 

choose between several output objects to be added to the document.  For more 

information, see Inserting Objects on page 39. To view other page types such as the 

notebook cover or footer page, and other copy pages, choose the appropriate page 

type from the combo box. The working area will only display the output objects that 

are visible in the selected page type. For more information on objects visibility, see 

Set Visibility Dialog Box on page 49. 

   1     2    3    4    5   6    7                                         8 

 

1 - Select objects. 

2 - Insert output object as Picture. 

3 - Insert output object as Text. 

4 - Insert output object as Barcode. 

5 - Insert output object as Check. 

6 - Insert output object as Shape. 

7 - Insert output object as xPress file (xpr). 

8 - Display the relevant part of the unit (original, copy, cover, etc). 

- Show which page to display in the work area. 

- Display either the undivided page – the universal background or title – or the 

changing sections on the page, like coupons. 
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The Format Toolbar (Zoombar) 

This toolbar, also known as the Zoombar, is designed for arranging and positioning 

the objects in the document. 

    1          2            3     4    5   6    7      8   9   10  11  12  13  14  15   16  17  18  19  20   21   22 

 

1 - Zoom In. 

2 - Distance from Display. 

3 - Zoom Out. 

4 - Send Backwards. 

5 - Send to Back. 

6 - Bring to Front. 

7 - Bring Forward. 

8 - Align Left. 

9 - Align Middle. 

10 - Align Right. 

11 - Align to Top. 

12 - Align to Center. 

13 - Align to Bottom. 

14 - Make same size – Height. 

15 - Make same size – Width. 

16 - Make same size – Width & Height. 

17 - Horizontal Spacing – Equal. 

18 - No Horizontal Spacing. 
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09 - Vertical Spacing – Equal. 

20 - No Vertical Spacing. 

21 - Copy Format of Selected Object(s). 

22 - Delete Selected Object(s). 

 

The Objects Tree 

The Objects Tree is like the map of the document. It includes all the objects arranged 

by levels. The upper level is the document. The level beneath is the input object 

(Copies, Input 1, Input 2, etc…) and the corresponding output object (Output 1, 

Output 2, etc…) lies beneath each input object. 

 

 

Output object - An object defining the type of display in the 

document. An output object may be Text, Picture, Barcode, etc. 

Input object - An object defining the data type displayed by the 

Output Object. An input object may contain constant text, 

number sequences, Excel data, etc. 

 

Each output object obtains its data from a single input object, but every input object 

may provide its data to more than one output object. The Objects Tree displays the 

input object above the output objects to which it provides its data. 

In the above illustration, the output object Output 2 obtains its data from the input 

object Input 2. This is understood by the location of Output 2 underneath Input 2 in 

the Objects Tree. 
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Characteristics Window 

 

In this window, at the lower left corner of the xPress
2
 

window, you can define the characteristic of each 

input and output objects of the document, as well as 

the characteristics of the document itself. 

The tabs and the content of this window change 

according to the selected object. 

 

Setting up the system 

Before you start working with xPress
2
, it is recommended to define print settings. 

These settings define the trays from which the printer takes each copy of the printed 

document, the offset of each paper tray, the use of Macro of the fly option etc... 

For example: if you print an invoice book in which you want the first copy to be 

white, the second to be blue and the third to be yellow - the paper source for each 

copy should be taken from a different paper tray in the printer. 

 

Paper Tray Definition 

Before you print a document with different paper sources for different copies, you 

must define the printer tray code for each paper tray. The tray definition can be done 

in one of two ways: PCL or Postscript. 
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In order to print different copies from different paper trays using PCL or 

Postscript commands, your printer must support PCL5 or PostScript 

language accordingly. This requires a PCL5 or Postscript printer driver. 

 

PCL Paper Trays 

1. From the Tools Menu select Options. The Options dialog box will open, 

select the PCL Paper Trays tab. 

 

2. From the Automatic Definitions combo box, select one of the existing 

definitions according to your printer type. If your printer type does not appear 

in the list box, you can define the tray numbers manually. In order to link the 

correct numbers to the corresponding trays, please refer to your printer’s User 

Guide, or contact your printer's vendor. 

3. If your printer does not support PCL5, you should select the Never Use PCL 

Tray numbers option. If your printer definitely supports PCL5, you should 

select the Always Use PCL Tray numbers option. If you are not sure, consult 
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your printer’s User Guide, or leave the Auto Select PCL Tray numbers so 

that xPress
2
 will try to evaluate whether your printer supports PCL5 or not. 

4. If you want the Tray codes to be saved as a part of the document and will 

override the default setting for this specific document, check the Save Setting 

to Document and Override Default Settings checkbox 

5. Click OK to confirm the settings. 

 

Postscript Paper Trays 

1. From the Tools Menu select Options. The Options dialog box will open, 

select the Postscript Paper Trays tab. 

 

2. Next you need to assign a paper tray definition to each paper tray you intend to 

use. Click the <…> button next to the paper tray you want to define. The 

printers dialog box will be opened. 

3. Select the Postscript printer driver suitable for your printer, and click the 

Properties button. The appropriate printer driver properties window will be 

opened. 
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4. From the printer's properties dialog box, select the desired paper tray, and click 

the OK button to confirm the printer settings, and again the OK button to 

confirm the printer selection dialog box. 

5. Once you defined a specific paper tray assignment, the  sign next to it will be 

changed to a  sign. Now you can repeat steps 2 to 4 and define all the paper 

trays. 

6. In case some of the paper trays contain paper which is slightly different in size 

from the primary document paper size (such as Tab stock covers) uncheck the 

Force paper size to tray settings during print checkbox. 

7. If you want the Tray definitions to be saved as a part of the document and will 

override the default setting for this specific document, check the Save Setting 

to Document and Override Default Settings checkbox 

8. Click OK to confirm the settings. 

 

 

If you are working with a custom paper size, you need to set the proper 

paper size for each tray in addition to selecting the paper tray as described 

in step 4 above. 

 

 

With some Postscript printers, there is no definition for paper tray 

numbers. Instead, you can define a different media color for each tray, and 

make sure that this definition is consistent with the media color definition 

for each tray in the printer's panel or controller. 

 

Other Print Settings 

1. From the Tools Menu select Options, the Options dialog box will open. Select 

the Other Print Settings tab. 
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2. Select the print emulation you want to be the default print emulation whenever 

you print a job to the printer from the options. 

3. Select whether you want xPress
2
 to use a "PCL Macro on the fly" technique 

when printing the file or not. This reduces the size of the print file and can lead 

to a more efficient printer work. Although this technique requires the printer to 

support PCL5 language, not all PCL5-supported printers are suitable for use 

with this technique. If you want to use this feature, select the Always option 

under Use PCL Macro of the fly option. 

4. Select the Always option under Force PCL custom page size to 101 if you 

want to instruct xPress
2
 to force the PCL printer driver to use code 101 when 

printing to custom paper size. Although this feature requires the printer to 

support PCL5 language, not all PCL5-supported printers are suitable for use 

with this feature. 

5. Click the Remove xPress
2
 Print Processor button if you want to uninstall the 

print processor used in the macro on the fly process. Click this button only if 

you want to uninstall xPress
2
 or upgrade the print processor. 
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6. If you want the print method to be saved as a part of the document and will 

override the default setting for this specific document, check the Save Setting 

to Document and Override Default Settings checkbox 

7. Click OK to confirm the settings. 

 

GDI Paper Tray Offset 

1. From the Tools Menu select Options, The Options dialog box will open, 

select the GDI Paper Tray Offset tab to define the paper offset for each tray. 

 

2. The tray offset allows you to shift the entire print image in any direction so as 

to achieve maximum accuracy of the print image on the paper. In order to 

move the image up or left, you may write negative values. 

3. Click OK to confirm the settings. 
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Event Log 

1. From the Tools Menu select Options, the Options dialog box will open, Select 

the Event Log tab to define which events will be logged by xPress
2
. 

 

2. To select the desired log file, click the browse  button and select the file. 

3. To start the event log with the selected file, you can click the Start Event Log 

Viewer, which will be started with the selected event log file even if it's not the 

standard log file of your xPress
2
 application. 

4. You can choose to ignore certain event types by removing the check mark next 

to the appropriate event type, or ignore a specific event type by adding its code 

to the Ignore specific events list. 

 

 

All changes you made to the Options dialog box will apply only for the 

current session of xPress
2
. To make these changes the default for future 

xPress
2
 sessions, you must choose Save Settings from the Tools menu. 
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Defining the Style Sheet 

The Style Sheet window includes the default settings for all types of input and output 

objects. When you create a new object it obtains its characteristics from the 

definitions in the Style Sheet. You can then change the specific object's 

characteristics in the Characteristics Window to achieve the desired result for that 

specific object. 

The Style Sheet dialog box shows the data tabs of the characteristic windows of each 

Output and Input objects type. 

1. From the Objects Menu select Style Sheet. The dialog box will open. 

 

2. Select the desired output or input object type from the tabs at the top of the 

Style Sheet window. 
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3. Change the values of the different characteristics of the desired output or input 

object type to the desired values. A detailed explanation of the role of each 

characteristic of each output or input object type can be found in Chapter 4: 

Output and Input objects on page 67. 

4. You can import and export the style sheet settings to an external file. You can 

also select which style sheet file will be used as the default for new documents 

5. Click OK to confirm the settings and save them for the current document. 

 

Other settings 

You can change the view options such as zoom, hide or show toolbars, and any other 

settings as well. 

To save the current settings as the Default settings, from the Tools Menu select Save 

Settings. 

The default settings will automatically apply whenever you open the xPress
2
 

software. 

 

Event Log Viewer 

The Event Log Viewer dialog box can be opened by selecting Event Log Viewer 

from the Tools Menu. 
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The Event Log Viewer is a tool in which you can view all events and statuses of the 

xPress
2
 software. There are five types of events, which can be noticed by the unique 

icon of each event type: 

 Error: This event occurs when a general error occurs, usually as a 

result of incorrect user input. 

 System Error: This event occurs when a system related error happens. 

 Security: This event indicates some security or licensing problem. 

 Warning: This event occurs when a suspicious activity takes place. 

 Information: This event indicates that the system is operating normally, 

but some information is being logged for future reference.  
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Chapter 3: Creating a Document 

The process of creating a new document is quiet simple. It consists of 4 steps:  

1. Define the characteristics of the new document (paper size, copies, etc). 

2. Insert output objects and input objects, and define their characteristics. 

3. Arrange the objects in the document. 

4. Print and/or save your document. 

 

Defining Document Characteristics 

To create a new document, select New from the File Menu, or click the New  

button in the Normal toolbar. A new blank document will be created, and a 

Document object will be displayed in the Objects Tree. Select the Document object 

to define its characteristics.  

The Characteristics Window of the Document object at the bottom left corner of the 

window displays 4 tabs: 
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Page 

 

 Click the Page Tab to define paper size and 

margins. From the Size combo box select the 

desired paper size. If you select a custom size, 

indicate in the corresponding boxes below the 

Width and Height (in millimeter units) of the 

paper. 

 Select the document orientation by clicking one 

of the radio buttons Portrait or Landscape. 

 In the Margins area indicate the document margin size. The measurements are 

indicated in millimeters. 

 

 

Not all printers support printing on a custom paper size. 

 

Object 

 

 Click the Object Tab to define the number of 

document-objects on each page. For example, to 

place 6 invoices on a page you can indicate 2 in 

Columns and 3 in Rows box. 

 In the Gap boxes, indicate the gaps between 

document-objects in columns and rows. 

 The total number of document-objects will be 

displayed underneath. 
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 In the Frame area you can choose whether the document objects will be framed 

with lines, crosses, dots, crop marks, etc… and select the properties of the 

frame, such as line length, color, width, bleed distance, etc… 

 

 

After defining the number of document-objects, you will need to create 

only one event. This document-object will be multiplied in the printed 

document according to the number of objects you have just specified. 

 

Amount 

 

 Click the Amount Tab to indicate the number of 

pages the document will include. There are 3 

options to choose from: 

 Fixed amount of pages: Simply write the 

number of pages you want the document to have 

in the No. of pages box. This amount refers only 

to the original pages and does not include the 

copies. 

 Fixed amount of notebooks: This option will be available only if there are 

notebook definitions. The total amount of pages in the document will be the 

number of notebooks you wrote multiplied by the number of pages defined to 

each notebook. For more information on this option, please refer to Notebook 

Settings on page 34. 

 Variable amount of pages according to a file size: This option allows you to get 

the amount of pages automatically, according to the size of the ASCII or PDF 

file from which you receive your data. For more information on this option, 

please refer to  ASCII as Input on page 89 or PDF as Input on page 92. The 
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Divide by amount of objects checkbox determines whether you want xPress
2
 

to divide the number of pages taken from the file by the amount of document-

objects defined for that xPress
2
 document or not. 

Job Split 

 

 Click the Job Split Tab to split the print job into 

several small print jobs. This allows the printer 

to perform actions that are job-oriented to the 

printout, such as to staple each notebook 

separately. There are 4 options to choose from: 

 Never split print job means that the entire 

document will be printed in one print job. 

 Split after # pages means that after the indicated amount of pages from the 

document, a new print job will be opened. 

 Split after # originals means that after the indicated amount of original pages 

from the document, a new print job will be opened. 

 Each notebook in a new job means that each notebook will be printed as a 

separate job, according to the notebook settings. 

 

Page Wizard 

The Page Wizard is designed to ease up the process of defining the number of 

document-objects in a page and calculating the margins and gaps. Click on Page 

Wizard from the File Menu to start the wizard. 
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5. Define the desired object Height and Width in the appropriate boxes. 

6. Select the desired page size from the combo box. 

7. Select whether the wizard can set the page as Portrait, Landscape or Any of 

them according to the best covered area. 

8. Check the box next to Force Top / Bottom / Left / Right Margin if you want 

the wizard to force any of the margins. 

9. Check the box next to the Force Vertical / Horizontal Gap if you want to 

force a fixed gap between the objects. 

10. A preview of the layout is displayed, as well as the number of objects on the 

page and the percent of usage of the objects out of the page area. 

11. To apply the settings calculated by the wizard to the document, click the Apply 

settings to document button. 

12. To cancel the wizard without making any changes to the document, click Exit 

button. 
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Page Object Visibility 

This window displays which objects to display – and hence to print – and which 

objects should be hidden. 

1. Click on Display Document Objects located in the File Menu to open the 

display window. 

2. Choose the objects you do not want to display by pressing on their number. 

3. Objects that are unselected (not pressed into the screen) will not be printed. 

 

Notebook settings 

When creating a notebook, such as an invoice book, ticket book etc., there are some 

additional definitions:  

1. From the Tools Menu choose Notebook Settings. The Notebook Settings 

dialog box will appear. 
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2. Select the Use notebook definitions box. 

3. Indicate the Number of pages in a notebook using the up/down arrows. 

4. To add a cover page to each notebook in the document, check the Cover 1 

checkbox. To add more cover pages (up to 5 cover pages), check the 

appropriate cover page checkboxes. 

5. For each cover page, select from the Paper Tray combo box, where the cover 

page will be printed from. 

6. Check the appropriate Print Page Frame checkbox to indicate whether the 

paper frame will be printed on the cover page. 

7. To add a footer page to each notebook in the document, repeat step 4 above 

with footer instead of cover page. 

 

Defining the Number of Copies  

After creating a new document, you can indicate the number of copies in the 

document. Every document must have at least one input object of the type Copies. 

This object is always called Copies and cannot be deleted. 
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Click on the (+) sign next to the Document-object in the Objects Tree. The Copies 

branch will be displayed. Select the Copies branch and in the Characteristics Window 

define the number of copies of the document. 

Although it is a unique object, the Copies input object is still an Input object. Please 

refer to  Copies as Input on page 75 for information regarding the different 

characteristics of a Copies input object. 

 

Protecting the Document 

You can protect a document by assigning a password to protect some document 

actions such as Load, Save, Print, Run Script and change counter value. To set up 

these passwords, select the Document password from the Tools menu. 

 

 

Add document information 

You can add information that will describe the document and make it easier to be 

identified in the future. To add such information select the Document Information 

from the File menu. 
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Saving the Document 

To save the document click the Save button  in the Normal toolbar. In the File 

Name text box, type the name of the document and browse to the folder in which you 

want to save the document. Click the Save button. 

 

Inserting Objects 

About Objects 

Every document created using the xPress
2
 software is constructed of objects: output 

objects and input objects. While creating a document you should place an output 

object on the xPress
2
 desktop, define its characteristics and link it to an input object 

that defines the displayed data. 

Sometimes a single input object can supply its data to more than one output object. 

For example, a ticket with 2 parts – one part containing the ticket number displayed 

as a barcode and the other part is a drinks voucher with the same number displayed as 

digits.  
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The following illustration shows the links between the document and its Object Tree. 

You can see that one input object (Main), such as the ticket number, can be displayed 

in 3 different output objects. 

 

 

The output object and its linked input are displayed in the Objects Tree on the same 

"branch", but the input appears one level higher than the corresponding output.  

 

Adding new Objects 

There are two methods of adding new output objects to the document. The first one is 

via a dialog box and the second one is to allow the xPress
2
 to create the desired 

default object and then change it to suit your needs. 

Selecting one of the two methods is done by checking or un-checking the  sign next 

to the Show Insert Dialog option in the Objects Menu. 
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Method 1: via dialog box 

1. From the Objects Menu select the Show Insert Dialog option. The  sign will 

be added to the left of the sub-menu. This feature enables the display of a 

dialog box every time you create a new object 

 

2. From the Objects Menu choose Insert Output and select the type of output 

object you wish to add (e.g. Text) from the sub-menu. 

3. The Add New Output dialog box will appear:  

 

4.  In the New Output Name text box, write a name for the output (the name 

Output # is displayed by default). 

5. If you want the new output object to receive its content from an existing input 

object, you can select it from the From an existing input combo box. 
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6. If you want the new output object to receive its content from a new input 

object, select the Create a new input radio button. 

7. From the Input Type combo box select the desired type of input object (e.g. 

Text). 

8. Write a name for the new input object in the Input Name text box (the name 

Input # is displayed by default). 

9. Click OK to confirm. The new output object will be created on the xPress
2
 

desktop, and the new output and input objects will appear in the Objects Tree. 

10. Now you can select the new output object, either from the xPress
2
 desktop or 

from the Objects Tree, and change its characteristics. Each output object has 

two tabs in the Characteristics Window, the Layout tab (which will be 

explained on page 47) and the Data tab. The Data tab appearance differs 

according to the type of output, and its content is explained in details in 

Chapter 4: Output and Input objects on page 67. 

11. You can also select the newly created Input object from the Objects Tree, and 

change its characteristics. All input objects have only one Tab in the 

Characteristics Window, the Input Tab, which is explained in detail in Chapter 

4: Output and Input objects on page 75. 

 

Method 2: default quick build 

1. Make sure that the  sign next to the Show Insert Dialog option in the 

Objects Menu is not checked. 

2. Select the type of output object you want to add by clicking the desired output 

type on the Objects toolbar. When moved to the working area, the mouse 

cursor will change its shape to a cross. 
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3. On the working area, draw a square using the mouse. When you release the 

mouse button, an output object of the type you chose will be created in the 

location you marked, and a new input text object will be created as well. 

4. In order to change the Input type to the desired input type, you can select it 

from the Objects Tree. From the Objects menu, select Change Input to and 

select the new desired input type from the sub-menu. 

5. In order to change the characteristics of the new output and input objects, see 

steps 10 and 11 above. 

 

 

When you create an Output type, except for picture outputs, the default 

input type that will be created is a Text Input. When you create a picture 

output, the default Input that will be created is a File Input.  

 

Combination of the two methods 

Methods 1 and 2 for adding new output objects can also be combined: 

 You can select the  sign next to the Show Insert Dialog option in the 

Objects Menu, and then use the mouse to select the desired output type, and to 

mark a place for it on the desktop. In this case, the output position will be set 

and the Show Insert Dialog option will be displayed when you release the 

mouse button. 

 On the other hand, you can remove the  sign next to the Show Insert Dialog 

option in the Objects Menu, and then select from the Objects Menu the 

Insert Output and select the desired type of output object you want to add 

from the sub-menu. In this case the desired output type will be added 

immediately to the upper left corner of the desktop with the default input 
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object type, and you can make all the adjustments and changes to both output 

and input objects later. 

 

Copy-Paste of objects 

You can copy output and input objects to the clipboard, and then paste it back to the 

same document or to another document. 

When you copy input objects to the clipboard, all dependent inputs are copied as 

well, e.g. when you copy a chain input object, all input objects in the chain are copied 

as well. 

When you copy output objects to the clipboard, all the inputs of these outputs are 

copied to the clipboard as well. 

If you paste an object (input or output) to a document in which an object with that 

name already exists, xPress
2
 will automatically change the name of the pasted object 

to a new unique name. 

 

Duplicating existing objects 

It is sometimes easier to duplicate an existing output object than to create a new one. 

All you need to do in order to duplicate existing objects is: 

1. Select the desired object or objects using the mouse, holding the shift key 

while clicking all desired objects. 

2. Select Duplicate Outputs from the Objects Menu. 

All the selected objects will be duplicated and placed near the position of the original 

outputs, but not in the exact place. The newly selected group contains only the new 

objects and not the original ones, which can now be moved to any other location and 

treated as any other output objects. 
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When you duplicate output objects, its input objects are NOT duplicated. However, 

the new output objects are linked to the same input objects to which the original 

output objects were linked. 

 

 

There are two differences between copy-paste and duplicate of objects: 

1. Copy-paste can be done on both input and output objects, and 

duplicate can be only done on output objects. 

2. When copy-pasting an output object, its input object is also copy-

pasted and new input and output objects are created. When 

duplicating an output object, it is duplicated and inserted under the 

original input of the duplicated object. 

 

Insert multiple objects at once 

You can create a large number of objects at once by using the "Add multiple inputs" 

dialog box from the "Objects" menu. This option is useful when you want to set a 

large number of input objects to one data file with identical characteristics besides the 

location of the fields from which you want the input objects to get the data. 
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Choose the type of the input objects you want to create, and then type the length of 

the fields, number of fields or column names for each input object (according to the 

type of input object you selected) and separate the data with a comma. 

Choose whether you like an output object to be created under each input object as 

well, and choose the type of output object to be created. 

Click the "Style Sheet" button and select from the style sheet dialog box all of the 

characteristics which will be the same for all objects created. It is very important to 

choose the file for the input objects to take the data from. It is very much 

recommended to select the file from the file manager, this way if in the future you 

will need to change the file for all input objects at once, it will be very easy to be 

done. For more information about the file manager, please see page 53. For more 

information about the style sheet, please see page 27. 
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Static vs. Variable Data 

The Output objects in xPress
2
 are always linked to an Input object. The type of the 

Input object defines whether the output object will be static (will always contain the 

same data) or variable (where the data varies from one page to another). 

 The static variable input object types are: Text, File. 

 The variable input object types are: Copies, Counter, Excel, List, System, and 

ASCII. 

 PDF Input can be either static or variable, depending on the characteristics of 

the specific PDF Input object. 

 Chain Input can be either static or variable, depending on the inputs in the 

chain. 

 

Layout 

A Layout box is created automatically for each output object added to the document. 

The Layout box indicates the general characteristics of the output object. 

 

 In the Position boxes, indicate (using the 

up/down arrows) the exact location of the object 

in the document: 

Top – the distance of the top of the object from 

the upper margin of the paper. 

Left - the distance of the left of the object from 

the left margin of the paper. 

Height – the height of the object. 

Width – the width of the object. 
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 Click the Set Visibility button to open a dialog box that will allow you to 

decide in which pages and copies of the document the object will be visible. 

 Click the Lock button to lock the location of the object, to avoid moving it 

unintentionally with the mouse. 

 Select Show Background Color to add a background color to the object. 

 The Frame area is used for indicating the borders of the object. 

Use the Shape combo box to choose the border shape. 

Use the Style combo box to choose the line style of the border. 

Use the Length box to change the length of the frame lines if the frame type is 

Cross. 

Use the Width box to choose the line width of the border. 

 To change the size and location of an object using the mouse, drag the object to 

the new location and change its size. By default, xPress
2
 will allow you to 

move the objects only within the xPress
2
 Desktop. If, for any reason, you want 

to place an output object outside the xPress
2
 Desktop (in the gray area) you can 

remove the  sign next to the Limit outputs to page option from the View 

Menu. 

 To define the exact size or location of an object, select the output object in the 

Objects Tree and define its characteristics in the object's Characteristics 

Window. 
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Set Visibility Dialog Box 

 

Here you can decide in which of the 

document's pages the output object will 

be visible or invisible. 

The list will show all page types available 

in your document, check the box next to 

each page type to make the output object 

visible, or uncheck the box to make it 

invisible. 

The Set Visibility also allows you to 

decide if the object should appear in the 

undivided section of the page or as part of 

the changing section, as explained in page 

17. 

 Click the Select All button to make an object visible in all pages. 

 Click the Unselect All button to make an object invisible in all pages. 

 Click the Invert button to invert the selection of visibility. 

To make the working area show different page type, choose the desired page type 

from the Show objects on combo box in the Toolbox, for more information about 

viewing different page types, see The Objects Toolbar (Toolbox) on page 17. 

 

Changing output objects layout easily 

After inserting an output object you can change its location relative to other output 

objects in the document. You can align output objects, set horizontal or vertical 

spacing and arrange their display order by levels.  
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Select the output objects you want to arrange using the mouse and the Shift key. 

When you select objects, the last object you select is always the leader object of the 

group; you can distinguish this output object from the rest of the group since its 

dotted border is red, while the borders of all the other output objects are gray. 

After you finish selecting the group of output objects, from the Format Menu select 

one of the positioning options: 

 Select the Align Menu and choose one of the direction options from the sub-

menu (Lefts, Centers, Rights, Tops, Middles, and Bottoms) all of the 

selected output objects will be aligned according to the leader object. 

 

 To equalize the size of the selected output objects, select Make Same Size 

from the Format Menu and choose one of the options displayed in the sub-

menu. All of the selected output objects will be resized according to the leader 

object (Width, Height or Both). 
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 To change the spacing between output objects: Select the output objects, and 

then from the Format Menu select either Horizontal Spacing or Vertical 

Spacing. To use this option, at least 3 output objects must be selected. 

         

o Select Make Equal to create equal spaces between the selected output 

objects. 

o Select Remove to remove the spaces between the output objects. 

 To change the graphic layout order of the output objects: Select the output 

objects, and then from the Format Menu select the Order option and choose 

one of the options displayed in the sub-menu: bring to front (1
st
 level), bring 

forward, send backward, send to back (last level). 

 

 

 

All formatting actions can be performed easily and conveniently from the 

Format toolbar. 
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Copying output object characteristics 

You can copy the characteristics of one output object to another output object. This is 

useful for quick characteristics editing and creating a uniform document. 

1. Using the mouse and the Shift key, select the objects you wish to change. 

Make sure that the leader object (the object that is selected last in the group) is 

the object you want to use as the source characteristics object. 

2. Click the Brush  button from the Format toolbar. 

3. The characteristics of the leader object will be copied to all objects in the 

selected group. 

 

 

All output objects in the selected group must be of the same type in order 

to successfully copy the characteristics. 

 

Output Objects Display Order Dialog Box 

 

The Output Object Display Order is 

used to comfortably view and 

change the order in which the 

Output Objects are created, 

displayed and printed on the page. 

 

 



Chapter 3: Creating a Document  53 

 

File Manager 

When you want to select a file as an input (picture, ASCII, PDF or Excel input 

objects), you may first insert the file into the File Manager, and then select the input 

file from the File Manager list of the input object. This will allow you, when you 

want to change the file in the future, to change it only once in the File Manager, 

instead of needing to change the file in each input object separately.  

To insert a file into the File Manager: 

 Select File Manager from the Tools Menu. The File Manager dialog box will 

appear. 

 

 To insert a new file, click the Insert button, the File dialog box will appear. 

 

o  Write a descriptive name for the file in the Name box. 

o Select the file path using the browse button. 
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o Choose whether the file is in Absolute or Relative location to the 

xPress
2
 document. If the document is a new document that was never 

saved, you must first save it using the Absolute option, since an unsaved 

document doesn't have a path on the drive. 

 To delete an input file from the File Manager, select the file and click the 

Delete button.  

 When selecting a file from the File Manager, if this file is an ASCII file or a 

CSV file, the properties of the file can be seen on the right hand side. 

 To change an input file linked to the File Manager 

o Open the File Manager window and select the file you want to change. 

o Click the Edit button, select a new file and confirm. 

o All Output Objects that receive their input from the selected file in the 

File Manager display the new input file.  

 

To link an Input to a file from the File Manager: 

 Select the desired input object from the Objects Tree. 

 In the Input tab of the Characteristics Window, select the File Manager check 

box and select the file name from the list of File Manager files. 

 

Substitution Rules 

Substitution Rules are a set of rules you can use to change the text that an output 

object receives from an input object. It is like a filter which can change all or some of 

the text. Substitution Rules are organized in groups, called Substitution Rule Sets. 

Each Substitution Rule Set is composed of one or more Substitution Rules. 
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To define Substitution Rules and Substitution Rule Sets, Select Substitution Rules 

Manager from the Tools menu. 

 

Define Substitution Rules 

 

In the Substitution Rules Manager 

dialog box, click the Insert Rule 

button and the Substitution Rule Edit 

dialog box will open. Select the 

properties of the Substitution Rule. 

 Select a name for the Rule, this 

name will be used to identify 

that Substitution Rule. 

 If you want the rule to be used 

only if the data in the input field 

is not empty, check the Perform 

rule only if data is not empty 

checkbox. 
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 In the Original String box, write the text you want to replace with a different 

text. 

 In the New String box, write the new text you want instead of the original text. 

 

If you want to replace or insert a text which is composed of 

unprintable characters (for example a form feed or a line feed 

character) you can type the hexadecimal value of that character in 

the following format: <0x**>, where ** is the hexadecimal value of 

the unprintable characters. For example, <0x0C> will insert a form 

feed character. <0x0D0A> will insert the carriage return and line 

feed characters. 

 In the Matching Method combo box, select one of the methods: 

o Any Part of Field – The original string will be searched and replaced 

with the new string anywhere in the text. If you select this option, select 

Match All to replace all appearances of the original string with the new 

string, or Match # Times to replace the original string only a specific 

number of times. 

o Whole Field – The original string will be replaced with the new string 

only if the data is exactly identical to the new string. 

o Start of Field – The original string will be replaced with the new string 

only if the data starts with to the new string. 

o End of Field – The original string will be replaced with the new string 

only if the data ends with the new string. 

 Select whether you would like to trim spaces from either side of the data in the 

Trim Spaces combo box. 

 Select Delete Empty Lines checkbox if you want to remove empty lines. 

 Select Delete All Content checkbox if you want to clear the data. 
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 If you want to delete characters from the beginning (left side) of the data, select 

Delete First checkbox, and type in the number of characters you want to 

delete. 

 If you want to delete characters from the end (right side) of the data, select 

Delete Last checkbox and type in the number of characters you want to delete. 

 If you want to delete characters from the middle of the data, select Delete 

checkbox and type in the number of characters you want to delete and the 

position of the deletion. 

 To add text before the data, select the Add Before checkbox and type in the 

text to add. 

 To add text before the data, select the Add After checkbox and type in the text 

to add. 

 To insert text within the data, select the Insert into the Field checkbox, type in 

the text to insert and select the position to add it in. 

 To make the field a given fixed length, select the Fill field with char 

checkbox, select which character is the padding character, determine which 

side to add the padding and enter the desired final field length. 

 Click OK and the new Substitution Rule will appear in the Substitution Rules 

list. 

 

Define Substitution Rule Sets 

Once you have finished defining the Substitution Rules, you must organize them in 

Sets in order to be able to use them: 
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1. Click Insert Set button, and type the name of the set. 

2. The new set will appear in the Substitution Rule Sets list. Click on the set, the 

sets properties will be enabled. 

3. Select a Substitution Rule from the list on the Substitution Rules list, and 

click the >> button. The selected rule will be added to the Rules in Set list. 

Repeat this step for each rule you want to add to the set. 

4. If you want to remove a rule from the set, select it in the Rules in Set list and 

click the << button. The selected rule will be removed from the list. 

5. You can change the order of the rules in the set using the up/down arrow 

buttons, the order of the rules is important since this is the order in which 

xPress
2
 performs the rules when the set is in use. 

6. Select Use First Successful Only option if you want xPress
2
 to perform the 

rules in the set until a rule is performed successfully, and skip all remaining 

rules. 
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7. select Use All Rules in Set  option if you want xPress
2
 to perform all the rules 

in the set regardless if any rule was successful or not. 

 

Use Substitution Rule Sets 

Once you finished defining the Substitution Rule Sets, you need to select a set to be 

used with a specific input object. Select the desired input object from the Objects 

Tree, this input object may be of a type: ASCII, Excel, System, Counter or List, and 

in the characteristics window of that input, check the Subst. Set checkbox and select 

the desired Substitution Rule Set from the combo box. 

 

Substitution Rule Sets Examples 

Following are a few examples that may assist in understanding the Substitution Rules 

and Substitution Rule Sets. Assume the following condition: 

Rule 1  Rule 2  Set 1 
Original String: "0" 

New String: "xx" 

Matching: Any Part of Field 

Match 2 times 

 Original String: "1" 

New String: "yy" 

Matching: Any Part of Field 

Match All 

 Rules: Rule1 

 

 

Use First Successful Only 
     

Set 2  Set 3  Set 4 
Rules: Rule1 

   Rule2 

 

Use First Successful Only 

 Rules: Rule2 

   Rule1 

 

Use First Successful Only 

 Rules: Rule1 

   Rule2 

 

Use All Rules in Set 

 

Original Data After Set 1 After Set 2 After Set 3 After Set 4 

000111 xxxx0111 xxxx0111 000yyyyyy xxxx0yyyyyy 

123456 123456 yy23456 yy23456 yy23456 

100000 1xxxx000 1xxxx000 yy00000 yyxxxx000 

ABC01 ABCxx1 ABCxx1 ABC0yy ABCxxyy 
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Tray Inserts 

 

The tray inserts dialog box is used to 

assign a specific tray to a certain 

page or page group. 

 To add an insert, click the 

Insert button and the Select 

Paper Tray for Pages dialog 

box will open. 

 To edit an insert, select the 

desired insert from the list, 

and click the Edit button. 

 To delete an insert from the list, select the desired insert, and click the Delete 

button. 

 

Select Paper Tray for Pages 

 

The Select Paper Tray for Pages dialog box 

is used to select the properties of the insert 

command. 

 Select the From and To pages for the 

insert. The page numbers are the 

numbers including cover and footer 

pages of a notebook, and copy pages. 

 Select the desired paper tray from the Paper tray list. 
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 Select the Return to previous tray after this page option if you want the 

insert to be for these pages only, or the Keep using this tray for all following 

pages if you want the following pages to be taken from the same paper tray 

until any other tray changes (whether by a different tray for a different copy or 

by a new insert) will occur. 

 Check the Repeat insert every x pages checkbox, and select the number of 

pages if you want the insert to be repetitive and not one time only. 

 Click the OK button. 

 

 

Before you print a document with different paper sources for different 

pages, you must define the printer tray code for each paper tray. The tray 

definition can be done in one of two ways: PCL or Postscript. For more 

information about setting the paper tray definition please refer to PCL 

Paper Trays on page 21 or Postscript Paper Trays on page 22. 

 

 

In order to print different copies from different paper trays using PCL or 

Postscript commands, your printer must support PCL5 or Postscript 

language accordingly. This requires a PCL5 or Postscript printer driver. 

 

Printing the Document 

Before printing, it is recommended to display the document in the Print Preview 

display. This display shows the full page according to the number of columns and 

rows you have defined. For more information, please see Defining Document 

Characteristics on page 32. 
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1. To view the document in Print Preview mode select File from the Main Menu 

and choose Print Preview, or click Print Preview  in the Normal toolbar. 

 

2. Click the arrow buttons to see the copies of the document and the other pages 

of the document. 

3. Click the Zoom In and Zoom Out buttons to see parts of the document in a 

more detailed manner. 

4. Click Close to return to the document or click the Print button to print the 

document. 

5. To print the document without displaying the Print Preview window, click the 

Print button  in the Normal toolbar. 
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6. The Select Print Method dialog box will appear. Select the desired print 

emulation you want to use. 

 

Click Print to continue the print process. 

7. In the Print dialog box select the page numbers for printing, and press the OK 

Button to confirm. The document will be printed according to the number of 

pages and the number of copies you have specified and according to the paper 

trays you have chosen for each copy. 

 

Faxing the Document 

 

In order to send fax from the xPress
2
 software, the fax module must be 

licensed. It is only possible to send fax from the xPress
2
 software when it 

is installed on windows 2000/XP or higher operating system. Additionally, 

make sure that the Microsoft Fax software is installed on your computer 

and is working properly. 

 

xPress
2
 software is able to send a document automatically via fax. The sent is made 

using Microsoft Fax software. When sending a fax from xPress
2
, the fax number field 

can be taken from any input field (including excel or ASCII), which enables you to 
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send each page or page group to a different fax number, without the need to send 

each fax manually. 

To fax a document automatically from the xPress
2
 software, please follow these 

steps: 

1. Click Fax Properties from the Tools menu, which will open the Fax 

Properties dialog box. 

 

2. For each fax property, select its content. The content can be either a static text, 

or from an Input field. The only mandatory parameter is the Recipient Number 

(destination fax number), all other parameters are optional. After setting the fax 

parameters, click OK. 

3. Click Send Fax from the File menu, this will present a Fax Send dialog box, 

where you may specify the range of pages to be faxed. 
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Click OK to send the document by Fax. 

4. Each page of the document will be faxed to the appropriate fax number. If two 

consecutive pages have the same fax recipient number, they will be sent in the 

same fax call. 
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Chapter 4: Output and Input objects 

Output Objects 

 Output as Text 

 

Use this output to display texts: 

 To format the text font, click the Font button 

and from the displayed dialog box choose the 

font type, font style, size and color. 

 The text can be stretched to fit into the object’s 

borders by using the stretch options. Click the 

vertical arrows and/or the horizontal arrows 

button in order to stretch the text to the dotted 

outline. Min/Max gives the minimum and 

maximum font size values allowed to the text 

to the object. 

 Click on one of the 9 Alignment options to choose the preferred combination 

of vertical (Top, Middle, Bottom) and horizontal (Right, Center, Left) 

alignments. 

 To indicate the spacing between the text lines: 

o Select Automatic spacing if you want the system to automatically 

choose spacing according to font size. 

o Select Stretch if you want the system to stretch the text lines over the 

entire output area. 

o Select Exactly to indicate the distance between lines in points. 
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 Use the up/down arrows in the Text Direction box to indicate the direction of 

the text in the text box. 

 Use the up/down arrows in Scale Width to stretch the fonts (starting at 100%). 

 Select the Visual or RtoL radio button if the text in text box is in reversed 

display. 

 In the Font dialog box, you can also decide how the text will act if it exceeds 

the limits of the area assigned to it by the output object, using the following 

options: 

o No Clipping – The area of the output object doesn't limit the text, so if 

the text exceeds the area of the output object, it will still be printed. 

o Clip Text – Those parts of the text that exceed the area of the output 

object will not be printed. 

o Wrap Text – Will cause the text to wrap automatically to the next line if 

it exceeds the limit of the output object. 

 

 Output as Barcode 

 

Use this output for printing Barcodes.  

 From the Barcode Type combo box, choose the 

Barcode encoding standard. 

 In the Add Before and Add After boxes, insert 

the text you want to add before or after the 

Barcode. 

 To display text in addition to the Barcode code, 

click the arrow of the Display Text combo box 

and select location of the display. 
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 Select the Text Size to be Automatic or an exact size (if a human readable text 

is displayed in addition to the barcode). 

 Select what will be the ratio between the tall and short lines in the barcode 

(only in barcodes that have both tall and short lines). 

 Click the Text Color box to choose the text color (if a human readable text is 

displayed in addition to the barcode). 

 Click the Bar Color box to choose the bar color. 

 To rotate the Barcode display, click on one of the Rotate buttons, according to 

the preferred direction. 

 If you want an empty barcode to be hidden when its data is empty, check the 

Hide Barcode if data is empty checkbox. 

 

 

Not every barcode standard can encode any type of data. Some barcode 

types can only encode numbers, while other can encode both numbers and 

letters. Some barcode types can only encode a limited length of data, while 

others can encode variable data lengths. You must know the different 

standards before using the barcode output. 

 

 

If the output area on the xPress
2
 desktop appears as a gray rectangle 

instead of a barcode, it means that the selected barcode encoding type 

cannot encode the desired data. 
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 Output as Picture 

 

Use this output for displaying a picture, such as a 

company logo. 

 To set a picture as a document background, 

select the Set as Background box. The picture 

will be stretched across the entire working area. 

 Check the Show on Screen box to show the 

background picture on the screen while 

designing the page. This option lets you place 

output fields easily on a preprinted document. 

 Check the Print on Paper box show the background picture in the printed 

document only. This option lets you work on the document without displaying 

the background picture on the screen. 

 You can rotate the picture by clicking the appropriate Rotate direction icon. 

Selecting the Auto rotate option will cause the picture to be displayed in the 

best direction according to the object dimensions. 

 You can reduce the pictures resolution by changing the percent in the 

Resolution box (this will cause faster printing but lesser quality). 

 Check the Stretch to Fit box to fit the Input picture to the size of the output 

object bounding box. 

 Check the Lock Ratio box to instruct xPress
2
 to keep the original height-width 

ratio of the picture to prevent distortions. 

 Alternatively, you can indicate the picture size and offset in the output box by 

choosing the Width and Height Percent, Horizontal and Vertical Offset and 

the attach direction of the picture. 

 



Chapter 4: Output and Input objects  71 

 

 Output as Check 

 

Use this output for displaying a Check Output in the 

MICR CMC7, E13B or OCR-A standards. 

 Select the type of standard you want to use from 

the Type section. 

 The letters in the Legend area represent the 

symbols separating the variable parts on the 

check. The symbols are different for each 

standard, and the legend will change according 

to the standard you selected. 

 You can rotate the check output by clicking the appropriate icon. 

 Click the Advanced button to open the Check Advanced features dialog box. 

 

 If you want to add text before / after the data, insert the letters representing the 

requested symbol in the text boxes in the Add Text area. 

 If you want to use a PCL printer font (a Flash / Dimm / Simm font) instead of 

the internal software font to print the MICR stripe, it can bee done by checking 

the Use a PCL printer font for the check printing checkbox and typing the 
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PCL font selection command in the PCL font command text box. Such a 

command can be something like that: 

<ESC>(8M<ESC>(s1p12v0s4b4457T 

The font selection command can be found in the printer PCL font list. When 

using a printer PCL font for the MICR stripe of the check it is recommended to 

ensure that in the driver's definitions under Advanced, the option Print 

Optimizations is Disabled. 

 

 

The use of a PCL command to select a PCL printer font is an advanced 

feature which is not recommended for beginner users. You must be 

familiar with the usage of the PCL language and the commands to select 

the proper font, otherwise the printed results may be wrong. 

 

 Output as Shape 

 

Use this Output for adding Shapes and lines to the 

document. 

 Click the Shape list box to choose an object 

shape. You may choose one of four options, the 

content of the characteristics window will 

change according to the selected shape type: 

 Line – indicate the line color, width and style 

and the combination of line and location around 

the object. 

 Rectangle – indicate the line color, width and style and the degree of rounded 

corners of the rectangle. 

 Ellipse – indicate the line color, width and style. 
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 Table - Indicate the line color, width and style and the degree of rounded 

corners of the table. For a Table also indicate the number of columns and rows, 

and the width ratio between columns. 

In the Columns Ratio text box, indicate the ratio between the columns. For 

example, for a 3-column Table if you write "1,1,1" - all the columns of the 

Table will have the same width. If you write "1,1,3" - the 3
rd

 column will be 3 

times wider than the 1
st
 column. If you write "1,2" for a Table that have more 

than 2 columns, the width of the last columns will be set according to the last 

number written. For example, in a 4 columns Table, indicating "1,2" is 

identical to indicating "1,2,2,2". By that, it can be understood that writing "1" 

will generate a Table in which all the columns width are equal, regardless of 

the number of columns. In order to achieve maximum accuracy in complex 

Tables, you can treat the numbers in the box as the width of the Table in 

millimeters, and write for example "22,46,53". 

 Triangle – indicate the line color, width and style, and the direction of the 

triangle. 

 Arrow – indicate the line color, width and style, and the direction of the arrow. 

 Star – indicate the line color, width and style, and the direction of the star. 

 If you want the shape to be hidden when its data is empty, check the Hide 

Shape if data is empty checkbox. 

 

 

The fields in the shape output characteristics window change according to 

the selected shape type. 
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 Output as xPress file 

 

This option is used when you want to use one xPress
2 

document as a variable element in a “parent” xPress
2 

document. This is especially useful, for example, 

when making a “coupon flier” – each “coupon” can 

be a different type of xPress
2 

output, while the entire 

flier is built of several “coupons”. 

 

 

To set as the background for the parent document, choose Set As Background. The 

background will cover the entire background. 

Clip to Output limits the background xPress
2 

document from exiting the borders of 

the work area and will delete anything that is outside the work area definitions. 

Select Stretch to Fit in order for the background to stretch to its maximum size 

within the given borders. 

The Lock Ratio button will enable you to change the size of the image without 

distorting it. 

The Refresh button will refresh the child xPress
2 

document, if changes have been 

made, so that the current display will be the correct and updated one. 

Use the Edit XPR File to change the child xPress
2 

document. 
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Input Objects 

 Text as Input 

 

Use this input to connect the output object to a 

constant text, such as Company details or any other 

fixed text. 

The text may be multi-line text. 

If you want to use a language that is different from 

your default operating system language in your 

document, you may need to use the Unicode encoding. 

In this case, check the Use Unicode checkbox. Note 

that you can't use Unicode in every situation, for 

example: you can't link a barcode or check outputs to 

an input that was defined as Unicode. 

 Copies as Input 

 

Use this input to connect the output object to a 

different text in each copy of the document, this is also 

used to select the paper source of each copy of the 

document. 

 To add another copy to your document, click the 

Add Copy button. 

 To switch between the data of the different 

copies, use the up/down arrows of the 

Currently Viewing Copy box. 

 To define a paper tray from which this document will be printed, choose the 

tray number from the Paper Tray list. 
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 In the Copy Data area, add the text that will be printed on this copy (for 

example Copy1, Original, etc.). 

 Repeat the above steps for adding additional copies. 

 To remove an existing copy, change the copy number in the Currently 

Viewing Copy box to the copy you want to delete, and click the Remove 

Copy button. 

 

 

Each document must have at least one Copies input object - that is the 

object with the name Copies. The paper source is set in this input object 

and it cannot be deleted. Additional Copies input objects can be added to 

the document in order to create different texts on each copy of the 

document, but the paper trays in these objects can't be set and will be 

ignored. 

 

 

Before you print a document with different paper sources for different 

copies, you must define the printer tray code for each paper tray. The tray 

definition can be done in one of two ways: PCL or Postscript. For more 

information about setting the paper tray definition please refer to PCL 

Paper Trays on page 21 or Postscript Paper Trays on page 22. 

 

 

In order to print different copies from different paper trays using PCL or 

Postscript commands, your printer must support PCL5 or Postscript 

language accordingly. This requires a PCL5 or Postscript printer driver. 
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 Counter as Input 

 

Use this input to connect the output object to a 

counter. 

 In the Start counting at box indicate the start 

number of the counter. 

 If you want the counter to count in loop, and 

that the counting will restart after reaching a 

certain number, select the Loop at checkbox 

and indicate the last number before the loop in 

the box. 

 In the Display at least box indicate the number of digits to be displayed in the 

Output data. 

 In the Increase by box indicate the difference between a counter value and the 

next value 

 In the After Every box indicate if the values will increase after each object (1) 

or after more than one object. 

 Select one of the objects at the bottom of this window to indicate the order of 

the printed numbers in the counter, according to the Object tab of the 

document. See page 32 for more details. 

 Click the up/down arrow to change the order direction and receive more 

options for the order of the printed numbers. 

 Flat and Deep radio buttons indicate the order of the numbers on the printed 

document.  

o Flat – distribution of numbers on the first page and then on the next 

pages. 
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o Deep – calculating the number of required papers in advance and 

ordering the numbers in a way that enables cutting the document and 

placing more that one set of documents in a pile, in the right order. 

 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules page 54 for more details. 

 Click the Advanced button to open the Counter Advanced features dialog box. 

 

 Check the Add Check Digit checkbox to add a checksum digit to the counter 

number. Click the Settings button to define the method in which this digit will 

be calculated. The Settings options are explained on page 79. 
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 The Flip Counter Position for Duplex Page has two sub checkboxes: 

Horizontal and Vertical. These will allow you to flip horizontally or vertically 

the position of the counter on each even page. This is effective when using 

duplex printing to make sure that the correct object will be printed on the back 

of each object on the front page. Example for Horizontal flipping: 

Front Page  Back Page 

(No Flip) 

 Back Page 

(Flipped) 

1 3  5 7  7 5 

2 4 6 8 8 6 

 Check the Do special first-last numbering order checkbox to change the 

counting order to the following order: assuming that there are 16 pages in the 

print job, the order will be: 1, 16, 2, 15, 3, 14, 4, 13, 5, 12, 6, 11, 7, 10, 8, 9. 

 Check the Save last counter value for next print job checkbox if you want 

xPress
2
 to keep the last counter value automatically between print jobs, and 

give a unique identification to the counter in the Counter ID box. If you 

choose this option, and you will print for example 10 pages in which the first 

page is number 1 and the last is number 10, then in the next print job the first 

page will automatically be number 11. It is possible to protect the ability to 

change the last counter value with a password. To do so, choose the Document 

Password option from the Tools menu, and assign a Counter Password to the 

document. 

 In the After loop return to number textbox fill in the number you want 

xPress
2
 to return to in case a loop is required and the counter is saved between 

print jobs. 

 Check the Change the numbers to Arabic digits checkbox if you want the 

counter displayed in the Arabic language. 
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Checksum Digit 

 

There are many methods to calculate a 

checksum digit. This dialog box enables you to 

choose the different properties for the 

calculation. 

 In the Weight Number box write the 

number that will be used to calculate the 

weight of each digit in the number that 

was calculated by the Counter Input. This 

number must have the same number of 

digits in it as the original number, if the 

number of digits is different, it will be 

extended or trimmed. 

 Choose which weight method will be used to calculate the weight of each digit in 

the Weight Method combo box: 

o Digits – If the calculated weight of a digit is greater the 10, then the 

result will be the sum of the digits of the weight. 

o Numbers – The weight of each digit will be untouched. 

 Choose from the Weight Alignment box the alignment of the checksum weight, 

this will be important in case the weight doesn't have the same number of digits in 

it as the number itself. 

 Choose from the Divider box the number in which the final weight of the number 

will be divided by. 

 Choose whether the checksum digit will be the remainder of the weight to the 

divider or the complement thereto. 
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 If the divider is greater than 10, then there may be a possibility that the check digit 

itself will be greater or equal to 10, and therefore will have more than 1 digit in it. 

The Leap Digit and Leap Digit Position will cause the checksum to be 

recalculated in such cases with a slight difference so that the new check digit will 

be smaller than 10. 

 Separator Text will allow you to add a fixed text between the original number and 

the checksum digit. 

 Test Check Digit button is useful to test yourself with the settings you chose. 

Type a number that you already know what its checksum digit should be in the 

Number box, and make sure that the correct digit is added to the number shown 

in the Result box. 

 

Checksum Digit Examples 

Data: 

Original number: 0000501 

Weight Number: 2121212 

Weight Method: Number 

Divider: 10 

Method: Complement 

Weight Calc: 

2 x 1 = 2 

1 x 0 = 0 

2 x 5 = 10 

1 x 0 = 0 

2 x 0 = 0 

1 x 0 = 0 

2 x 0 = 0 

Weight = 12 

Check Digit Calc: 

12 / 10 = 1 (2) 

10 – 2 = 8 

 

Check Digit = 8 
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Data: 

Original number: 0000561 

Weight Number: 7137137 

Weight Method: Digit 

Divider: 10 

Method: Remainder 

Weight Calc: 

7 x 1 = 7 

3 x 6 = 18  9 

1 x 5 = 5 

7 x 0 = 0 

3 x 0 = 0 

1 x 0 = 0 

7 x 0 = 0 

Weight = 21 

Check Digit Calc: 

21 / 10 = 2 (1) 

 

Check Digit = 1 

 

 

Data: 

Original Number: 1200667 

Weight Number: 8765432 

Weight Method:  number 

Divider: 11 

Leap Digit: 5 

Leap Digit Pos: 4 

Method: Complement 

 

 

 

New Number: 1205667 

(put the digit 5 in the 4
th
 

position from the left) 

Weight Calc: 

2 x 7 = 14 

3 x 6 = 18 

4 x 6 = 24 

5 x 0 = 0 

6 x 0 = 0 

7 x 2 = 14 

8 x 1 = 8 

Weight = 87 

 

New Weight Calc: 

2 x 7 = 14 

3 x 6 = 18 

4 x 6 = 24 

5 x 5 = 25 

6 x 0 = 0 

7 x 2 = 14 

8 x 1 = 8 

Weight = 103 

 

Check Digit Calc: 

78 / 11 = 7 (1) 

11 – 1 = 10 

 

Check Digit = 10 

 

 

Do Leap Process… 

 

 

New Check Digit: 

103 / 11 = 9 (4) 

11 – 4 = 7 

 

Check Digit = 7 
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 File as Input 

 

When the output object receives its content from a file, 

such as a graphic picture or xPress
2 

file, it should be 

linked to the file input type. 

 To choose the file click on the browse  

button and locate the picture file, select the file 

and click Open to link it to the object. 

 Click the radio button that indicates the type of link the path to the file will 

have: 

o Choose Absolute to link a file to a specific location.  

o Choose Relative to indicate a location relative to the location of your 

document. It is recommended to choose the Relative option when you 

intend to open the document from another computer. 

 Select the File Manager checkbox if you want to select a file via the File 

Manager. For more information regarding the File Manager see page 53. 
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 Excel as Input 

 

You can connect the output object to an input Excel 

file. 

 To choose the file click on the browse  

button and locate the Excel file, or use the File 

manager. Please refer to  File as Input on page 

83 for more information. 

 

 Indicate the data location from the Excel file: 

o From the Sheet combo box, choose sheet name . 

o In the Column box indicate the column from which to receive data. 

o In the Starting at Row box indicate the row number from which to 

receive data. 

o If the data acquired from Excel is not consecutive, select the radio button 

Get Row from the Counter Input and select the counter input object 

that indicates the linked row numbers. 

 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules on page 54 for more details. 

 If you want to use a language that is different from your default operating 

system language in your document, you may need to use the Unicode 

encoding. In this case, check the Use Unicode checkbox. Note that you can't 

use Unicode in every situation, for example: you can't link a barcode or check 

outputs to an input that was defined as Unicode. 
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It is highly recommended NOT to change the content of the Excel file 

while the xPress
2
 software is open and the Excel file is selected in an input 

object. Doing so may cause unexpected results. 

 

 List as Input 

 

Use this input type to link an output object to a list of 

items. 

 Items on the list can be a text, a number or a 

combination of the two. 

 To insert a list entry, click the Insert button and 

type the entry in the displayed box. 

 To edit an existing entry, select the desired entry, click the Edit button, and 

type the new entry in the displayed box. 

 To delete an existing entry, select the desired entry, and click the Delete 

button. 

 To delete all the entries in the list, click the Clear List button. 

 Use the up/down arrows to change the order of the list items. 

 Select the Get Row from Counter Input check box to link the list to an 

existing counter, and select the counter from the list box below. 

 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules on page 54 for more details. 

 Click the Advanced button to open the List Advanced features dialog box. 



Chapter 4: Output and Input objects  86 

 

 

 Automatic folder synchronization: 

o Check the Synchronize the list to a folder checkbox and select the 

desired path to this folder if you want the list to automatically contain 

the names of the files in a specific folder. 

o If you want the list to automatically synchronize itself with the files in 

the selected folder, and whenever files will be added or removed from 

the folder they will automatically be added or removed from the list, 

select the Keep list automatically synchronized with the folder 

option. 

o If you want to add the files currently existing in the folder to the list, and 

keep them in the list without automatically synchronizing it with the 

folder in the future, select the Read folder files and keep list static 

option, and click the Read Now button. 

o If you want to add only some of the files in the folder into the list, e.g. 

only files with a specific extension, check the Filter files checkbox and 

type the filter in the text box. 
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 Automatic number filling: If you want to add a series of numbers to the list, 

you can do this automatically by selecting the range of numbers in the To and 

From boxes, and clicking the Add Now button. 

 

This function is useful if you want to make a list with page numbers 

and connect the presentation of PDF pages to this list (by chaining 

the list after a text PDF input containing the path to the PDF file 

with a comma between the filename and the page number).  

 

 Database as Input 

 

Use this input type to link an output object to a 

database via ODBC connection. 

 Type the ODBC database connection name in 

the DSN text box. The data source must be a 

user data source. 

 Type the SQL query you want to perform on the 

database you chose in the SQL text box. 

 You may select a Field Separator that will be 

added between each two consecutive data fields. 

 Select how many data lines will be returned each time in the Display Rows 

box. 

 Select the Get Row from Counter Input check box to link the SQL query 

return order to an existing counter, and select the counter from the list box 

below. 

 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules on page 54 for more details. 
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Adding a user data source (DSN) 

In order to create a new data source, follow these steps: 

1. Go to the "Control Panel", and select the "Administrative tools", and then 

select the "Data Sources (ODBC)" icon. 

2. From the "User DSN" tab, click the "Add…" button. 

3. In the "Create New Data Source" dialog box, select the desired database driver 

you want to use (for example "Microsoft Access Driver (*.mdb)"), and click 

"Finish". 

4. According to the selected driver, a setup dialog box will be issued. If you 

selected the "Microsoft Access Driver (*.mdb)" all you need to do is to type a 

"Data Source Name" and a use the "Select…" button to choose a database file. 

Click the "OK" button and close all dialog boxes. 

 

5. From the DSN selection button in the database input property, select the newly 

added DSN, it should appear under the "Machine Data Source" as a type 

"User". 
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 System Data as Input 

 

Use this input type to connect the output object to 

information received from your computer system or 

the document itself, such as time and date format, or a 

random number. This field can also be used to print 

the number of pages or number of objects in the 

document or the path of the document. 

 Subst. Set checkbox and combo box are used to 

assign a Substitution Rule Set to the input 

object, see Substitution Rules on page 54 for 

more details. 

 

 ASCII as Input 

 

Use this input type to link an output object to an 

ASCII File. 

 To choose the file click on the browse  

button and locate the ASCII file, or use the File 

Manager. Please refer to  File as Input on 

page 83 for more information. 

 Click the Refresh Data button if the data in the 

ASCII file was changed after you set the link. 

 Select the Get Row from Counter Input check box to link the list to an 

existing counter, and select the counter from the list box below. 
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 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules on page 54 for more details. 

 To set the details of the ASCII file, click the Advanced button and the ASCII 

Input Advanced features dialog box will be opened. 

 

 First select the type of ASCII file you are using by clicking Flat ASCII File or 

CSV File at the top of the dialog box. 

 If the file is a flat ASCII file: 

o Select the size of the read block (in characters and lines units) at the 

Read Block Size, Width and Height boxes. 

o Select the start position of the reading in the ASCII file in terms of 

Columns, Lines and Pages from the beginning of the file. 

o Select the amount to proceed in each reading step from the file in terms 

of Columns, Lines and Pages. 

 If the file is a CSV file: 
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o Select the delimiting characters that will separate the fields of the file. 

This is usually the “,” (comma) character, but it may be any other 

character. If the file is separated by the "Tab" character, you must write 

its ASCII hexadecimal value, since this is an action character, so you 

must write "<0x09>" in case it is a Tab separated file. 

o Select which field of the CSV file you want to read (counting from left 

to right, when the first field is number 1). 

o Select what is the size of the block you want to read (how many lines). 

o Select whether you want the field to be a search field, if so check the 

Use Field Search checkbox: 

 Select the key text to be searched by clicking the <…> button and 

selecting a fixed text, or an input field as the input to the search. 

 Select the field number to be used as a key field. 

 Check the Key Field is Sorted checkbox if the CSV file is sorted 

according to the key search, this will increase search speed, but 

may result in wrong results if the CSV file is not sorted. 

 In the Number of Lines box, select how many lines will be 

returned (if return type is a block) or which line to return (if the 

return type is a line). 

 Select whether the return type is a Single Line or a Block of all 

the lines found in the search. 

 Type in the Default Text to be returned if the key is not found at 

all, or not found enough times as the Number of Lines parameter 

indicates. 

 Select a translation table for the file, if needed, in the Translation Table 

combo box. 
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 Select whether you would like xPress
2
 to trim spaces from either side of the 

field in the Trim Spaces combo box. 

 If you would like to add a fixed text before and/or after the field text, type it in 

the Before and/or After boxes. 

 If you want xPress
2
 to add the result of the ASCII input to a result of another 

input and use it as the final result of the ASCII input object, check the 

Mathematically add data to input checkbox, and select the desired input 

object from the combo box. 

 Once finished, click the OK button to close the dialog box. 

 

 PDF as Input 

 

You can connect the output object to an input PDF 

file. 

 To choose the file click on the browse  

button and locate the PDF file, or use the File 

manager. Please refer to  File as Input on page 

83 for more information. 

 

 Indicate the type of reading from the PDF file: 

o Check the Static box to read a specific page from the PDF, and then 

select the page number from the Starting at Page box. 

o Uncheck the Static box to read different pages of the PDF file, and then 

select the page number to start the reading from the Starting at Page 
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box. xPress
2
 will advance by one page in the PDF document for each 

new document object. 

o If the page number reading order from PDF is not consecutive, select the 

radio button Get Page from the Counter Input and select the counter 

input object that indicates the linked page numbers. 

 

 

Another useful way to control the presentation order of the PDF pages is to 

connect the picture output into a chain input instead of to the PDF input. 

Then inside the chain you put the PDF input, followed by a comma (",") 

character (as a static text) and followed by another input that contains the 

page number in any order (e.g. a list input with numbers in it, or an Excel 

file with the page numbers in it). This will allow you to print the PDF in 

any page order you like. 

 

 

 Chain as Input 

 

You can connect the output object to a chain of input 

objects. Items in the chain can be input objects, fixed 

text or a carriage return sign. 

 To insert an item to the chain, click the Insert 

button and use the Chain Item dialog box to 

define the nature of the Chain Item. 

 To edit an existing Chain Item, select the 

desired Item, and click the Edit button. 

 To delete an existing Chain Item, select the desired Item, and click the Delete 

button. 



Chapter 4: Output and Input objects  04 

 

 Use the up/down arrows to change the order of the Chain Item. 

 Subst. Set checkbox and combo box are used to assign a Substitution Rule Set 

to the input object, see Substitution Rules on page 54 for more details. 

Chain Items 

 

Each Item in the chain can be one of the following: an input object, a fixed text or a 

carriage return sign. Select the desired Item Type using the radio buttons on the left. 

 Input Object – Select the desired Input Object from the list, Input objects that 

can be added to a Chain can be from any type but File, PDF or Chain. 

 Fixed Text – Type the text you want to add to the chain. 

 Carriage Return – This will add a carriage return character (New Line) to the 

chain. 

 

 

You can't make a chain input object that will contain other chain input 

objects. 
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 Connector as Input 

 

This is used when you want to use one xpr file as an 

input for a “parent” xpr file. (See xPress
2  

Document 

as an Output on page 74) 

Name of Connected Input Object is the name of the 

object in the “father” xPress
2 

document that is being 

imported. 

Sample Data for Design Mode – Since the link 

between the father and son documents will be 

performed only at print time. This gives a sample 

value to view while designing and for previewing the 

page. 

 If you want to use a language that is different from your default operating 

system language in your document, you may need to use the Unicode 

encoding. In this case, check the Use Unicode checkbox. Note that you can't 

use Unicode in every situation, for example: you can't link a barcode or check 

outputs to an input that was defined as Unicode. 
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Chapter 5: Scripts 

The Script is a tool which enables you to create very powerful xPress
2
 applications. 

Using a Script, it is possible to embed a Basic like program in the document, this 

program will have functions and commands that their arguments are taken from the 

document and their results will influence the document. 

Among the actions that can be performed in the script, you can find all of the 

standard basic commands and statements, such as: 

 Variable definitions (Integer, Float, String). 

 Loops (For-Next, Do-Loop, While-Wend). 

 Logical conditions (If-Else-Endif). 

 Mathematical actions. 

 String manipulations 

 Definition of new functions and subroutines. 

The software allows two types of scripts: The master script and an internal script for 

each output object. A complete list of all the legal statements and functions possible 

in the xPress
2
 script language is available in the on-line help of the software. 

 

 

Using scripts is only possible if the script module is licensed. 
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The Master Script 

The master script allows you to create programs that perform actions with influence 

on the entire document, such as: 

 Read / Change values of input object properties. 

 Read / Change values of the document properties, including the number of 

pages in the document. 

 Print the document to any printer. 

 Reading data from external files and inserting it into input objects. 

 

Running the Master Script 

To run the Master Script of the document, choose the Run Master Script option 

from the Script menu. The script will run from start to end continuously. 

 

Editing the master Script 

To edit the Master Script of the document, choose the Edit Master Script option 

from the Script menu. The script editor dialog box will appear, and within it you can 

see the document's master Script. 
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In this dialog box you can edit the script's text, and make additional actions that will 

make it easier for you to work with scripts. Additionally, in this dialog box you can 

run the script line by line in debug mode to diagnose malfunctions and make sure the 

script you wrote is valid. 

 

Commands and options in script editing 

The menu of the script editor includes the following options: 

File Clear Contents Clear all the content of the script editor. 

 Import Script Import external text to the script editor. 

 Export Script Export the existing script to an external file. 

 Save Save and update the script to the xPress
2
 document. 

 Exit Exit the script editor and return the xPress
2
 software. 

Edit Undo Undo last action. 

 Redo Redo last action. 
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 Cut Cut the selected text to the Clipboard. 

 Copy Copy the selected text to the Clipboard. 

 Paste Paste the text from the Clipboard. 

View Error Window Show / Hide the Error window. 

 Variable Window Show / Hide the Variable window. 

Debug Run Script Run the script from start to end continuously. 

 Stop Script Stop the running of the script. 

 Step Into Run the script one line at a time, step inside 

functions.  Step Over Run the script one line at a time, step over functions. 

 Step Out Run the script until exiting the current function. 

 Run To Cursor Run the script to the current cursor position. 

 Toggle 

Breakpoint 

Toggle a breakpoint for the script. 

Help Help Topics Show the script help screen. 

Output Object Script 

You can assign a script to each output object. This script can perform actions that will 

affect this object. Usually the purpose is to change the way the object displays the 

data according to the value of the data itself. A simple and common example is to 

display text in a different color (for example red) when the data answers some criteria 

(for example a negative value). 

In order to create a script to an output object, you need to choose the object from the 

objects tree, select the Script tab, and write the script directly in the textbox. 

However, it is usually more comfortable to edit the script in a separate window, 

which is also larger and you can see different colors according to the different parts 

of the script. 
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The most common commands in the output object script are the GetMyData 

command which returns the data of the object at print time, and the SetMyProperty 

command that changes the value of a specific property of an output object. In the 

above example, if we assume that the output object is a Text object, it receives its 

data from a Counter input object, and the numbering starts from 1 and increases in 

each page, then on the first page the text color will be blue and on the rest of the 

pages the text color will be red. 

A complete list of all the existing functions and the properties for each output object 

type in the xPress
2
 script language is available in the on-line help of the software. 
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Chapter 6: Running in command line 

Command Line options 

After you finished preparing your documents, there is sometimes a need to run 

xPress
2
 with a specific document on a given data file in command line (usually as a 

part of an external script of another system). In order to do this, xPress
2
 has the 

ability to run in command line mode with a variety of arguments to perform different 

actions. The syntax of these arguments is: 

xPress <xPress file> [options] 

where <xPress file> is the full path name to the document file you want to open with 

the software and [options] is one or more of the following options: 

/p Print the opened xPress
2
 file to the default printer. 

/pt <printer name> Print the opened xPress
2
 file to the specified printer. 

/preview Open the xPress
2
 software directly to print preview 

mode. 

/fm <file item> <file name> Replace the file manager item specified with the new 

data file specified. For more information about the file 

manager see page 53. 

/xps <file name> Use the specified xPress
2
 startup file (XPS file) to 

determine the initial values for the input objects and 

for the document object. More information about 

xPress
2
 startup files is followed hereafter. 

/runscript Run the master script after opening the xPress
2
 file. 

/setpages <pages> Change the amount of pages in the main Document 

object to be this amount. 
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/minimized Open the xPress
2
 software in minimized mode 

/hidden Open the xPress
2
 software in hidden mode, make sure 

you use this option only when you use the automatic 

print mode which will close the software 

automatically, otherwise it will be opened and hidden 

and will only be able to close it from the task 

manager. 

 

 

If any of the arguments (such as a file name or a printer name) contains 

spaces in it, you will need to write it between two quotation marks ("…"). 

 

 

If you use the /p or /pt options (meaning automatic printing), then the 

xPress
2
 software will be closed after the document was printed, otherwise 

the xPress
2
 software will remain opened. 

 

XPS Files (xPress
2
 Startup Files) 

XPS files are used to assign values to input objects and to the document object during 

the startup of the xPress software, these values are written in a textual file that is 

composed of consecutive lines, each of them has the following structure: 

ObjectName.Property=Value 

 ObjectName The string "Document" if this is the document object, or the 

name of the input object. 
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 Property The name of the property to be changed. You can find a list 

and a description of all the property names for each input 

object type in the online help under scripts. 

 Value The value to be assigned to the selected property. 

An example of an XPS file can look like that: 

Document.NumberOfPages = 10  

Document.Orientation = 1 

Input 001.Text=NewText 
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Chapter 7: Frequently Asked Questions 

Here are some of the most frequently asked questions received from xPress
2
 users: 

 

(1) Question:  

How do I change the input of an existing output object to a different input object? 

(1) Answer: 

Link the objects using the Object Tree: Select the output object in the Objects Tree 

and drag it to the input object you want to link it to. Release the mouse button when 

the object is located on the correct Input. The output object will now appear under the 

new input object in the Objects Tree. 

 

(2) Question:  

I have linked a few output objects to an existing Input. Therefore the Objects Tree 

includes inputs without a linked output. Can I delete all of them at once? 

(2) Answer: 

You can delete all unused input objects by selecting the Clear Unused Objects 

option from the Objects Menu. 

 

(3) Question:  

I have created objects in my documents, using the automatic names (output1, output2 

etc). How can I give meaningful names to these objects? 

(3) Answer: 

In order to change the name of an object, right click the object on the Objects Tree 

and select Rename from the Context Menu. 
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(4) Question:  

I have created a counter input to a text output. How do I change this input to a list 

input? 

(4) Answer: 

To change the input type, right click the Input in the Objects Tree, select Change 

Type To from the Context Menu and select the required new input type. 

 

(5) Question:  

When I am printing in duplex, and have more than one object on the page, the even 

pages are supposed to be flipped left-right. That way the correct object will be printed 

on the back side of each object from the front of the paper. How can I do it? 

(6) Answer: 

Select the counter objects in your document, and in the input characteristics, click the 

Advanced button. In the dialog box, check the appropriate Horizontal or Vertical 

checkbox (according to the type of duplex you are using) under Flip Counter 

Position for Duplex Page. 

 

 (6) Question:  

When I click on an object in the Working Area, the corresponding objects in the 

Objects Tree are highlighted. Is it possible to select an object in the Working Area by 

clicking on it from the Objects Tree? 

(6) Answer: 

Yes, it is possible. Double click the desired object on the Objects Tree and it will be 

selected on the Working Area. 
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(7) Question:  

I added an output object under the Copies input object, but in the working area I see 

only the text of the first (original) page. Is it possible to see the other copies in the 

working area? 

(7) Answer: 

Yes, it is possible. Select the desired page type (e.g. copy 1) from the Show objects 

on combo box in the Toolbox, and then only the objects that are visible on that page 

type will be displayed on the working area. 

 

(8) Question:  

How can I make an object to appear only on the notebook cover page and not on 

normal document pages? 

(8) Answer: 

Select the desired object, and in the layout characteristics, click the Set Visibility 

button. In the dialog box, check only the notebook cover page and uncheck all other 

page types. 

 

(9) Question:  

How can I tell what was the xPress
2
 version used to create a certain document? 

(9) Answer: 

From the File Menu, select Show File Version. The version of the document will be 

displayed in a dialog box. 
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 (10) Question:  

I want to make a document that is 5cm * 9cm in size. Is there a way I can instruct 

xPress
2
 to make the calculations needed for the margins and amount of objects 

automatically? 

(10) Answer: 

Yes, it is possible. Select Page Wizard from the File menu. In the dialog box, type 

the appropriate object height and width, and select the page size. xPress
2
 will 

calculate the best layout to place the selected document-object's size on the selected 

page size and will show you a preview. If the layout is acceptable, click the Apply 

Settings to Document button. The settings you chose will be implemented to your 

xPress
2
 document. 

 

(11) Question:  

I am using a database input object to read data from an MDB file, but if I change the 

SQL query, the result is not updated. Only after I reselect the DSN the new SQL 

query is being used. 

(11) Answer: 

The DSN you are using is probably a File DSN and not a User DSN. You must 

redefine your DSN and select the new DSN in the database input object. 

 




